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Introduction 
In this document, Software or Web Site Usability Testing with Morae, walk through how to use 
TechSmithôs Morae to conduct a usability test for computer applications, web sites, or anything else that users 
interact with on a computer. 

This document is intended for people that are already familiar with the concept of usability testing.  

If youôre new to usability testing, start with Usability Testing Basics which explains the basics of usability 
testing, including information about how to figure out what to test, when to test, and how to test. Usability 
Testing Basics is available on the Morae Resource CD and in the Morae Learning Center 
(http://www.techsmith.com/learn/morae/default.asp).  

Software or Web Site Usability Testing With Morae 

Morae is the premier software for deeply understanding customer experienceséand sharing those insights 
clearly and powerfully. From usability testing to focus groups and beyond, Morae helps you transform designs 
and marketing to make things people love.  

For a software or web site usability test, Morae records desktop activity on the userôs computer and camera 
video of the user. Using TechSmith Corporationôs patented Rich Recording Technology, Morae Recorder 
captures all system events, including mouse clicks, web page changes, onscreen text, and more.  

We will walk you through completing a test with Morae with the following topics: 

 Set Up the Test 

 Record and Log Test Sessions 

 Analyze and Present Findings 

 How to Retrieve Your Key Measures from Morae 

The document also contains the following appendices: 

 Appendix A: User Research Request 

 Appendix B: Test Protocol Document 

 Appendix C: Example Usability Test Report 

 Appendix D: Usability Test Checklist 

http://www.techsmith.com/learn/morae/default.asp
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Software or Web Site Usability Testing 
Considerations 
This is the type of testing most people imagine when using the term ñusability test.ò  In it, participants conduct 
real world activities on a working prototype or a real version of the software, and observers measure 
efficiency, effectiveness, and satisfaction along with other usability measures. 

During planning, consider carefully what systems (e.g., testing computer) will be used in the test.  A computer 
needs to be set up to look like a realistic system that mimics how users actually interact with the product. 
Make sure your test machine behaves and looks familiar to participants ï or be prepared to assist participants 
if the study calls for something unfamiliar.   

The productôs development team also needs to provide: 

 Working software or a functional prototype on which participants can complete tasks 

 Assistance with data (e.g. information from a test database, a media hosting account containing pre-

uploaded media, or a fake credit card number for making online purchases):   

 A method to reset the software to its original state and save the userôs work when appropriate 

Procedure 

The test may be conducted in your lab (which can be as simple as a room with a computer and Web cam) or 
remotely using UserVue. Morae or UserVue records the screen, RRT data (such as mouse clicks and web 
page changes), and any notes or markers logged by Observers, and Morae can capture the participantôs face 
with a Web cam via Picture-in-Picture mode.  Use the default configuration provided for software or Web 
usability testing in Morae to record the test. 
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Set Up the Test 
After you figure out what to test and the goals for testing, use the steps in this section to set up the test in 
Morae Recorder.  

 

To set up a test in Recorder: 

1. Create a Study Configuration 

2. Define the Scenario 

3. Define Tasks 

4. Define Markers 

5. Define Surveys 

6. Save Study Details 

7. Configure Recording Details 

8. Complete Test Set Up 

 This document walks through this process at a high level. You can find more information on the full 
procedures and options in the help included in the Morae components or find both video and written 
tutorials in the Morae Learning Center: http://www.techsmith.com/learn/morae/default.asp.   

http://www.techsmith.com/learn/morae/default.asp
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1. Create a Study Configuration 
A study is a group of test sessions where participants complete the same tasks. In Morae, a study 
configuration file (.mrcfg) defines all test-specific information. This includes the scenario, tasks, markers, and 
surveys. 

You use the same study configuration to record each of the test sessions. Only recordings with the same 
study configuration can be later analyzed together in Morae Manager.  

Morae Recorder includes template study configurations to help you define study configurations for different 
kinds of studies. Templates contain sample tasks, markers, and surveys, along with pre-configured 
Recording Details which define how to record the session. 

When you open Recorder, create a new study configuration based on Software or Web Usability Study. 
When you click OK, the template study configuration opens in Recorder. 

 

2. Define the Scenario 
A scenario gives the participant the background to complete the tasks. It tells them why they are doing the 
tasks and any introductory information they may need to complete the task. 

The scenario should be realistic and allow the participant to relate to the situation. For more on how to create 
a scenario, see Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning 
Center. 

For example, to find out how users interact with your company web site, the scenario may be:  

You will perform up to 4 different tasks using a web site. 

You have just purchased a copy of SnagIt and youôre interested in learning more about the company 
that makes it, TechSmith.  Follow the instructions for each task and then perform the task as you 
would if you were actually doing this task for yourself.   

Please talk out loud while you work, and keep a running dialog of your thoughts, actions, expectations, 
and reactions. 

Do you have any questions? 

http://www.techsmith.com/learn/morae/default.asp
http://www.techsmith.com/learn/morae/default.asp
http://www.techsmith.com/learn/morae/default.asp
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Scenario in Morae Configuration 

 Recorder > Modify Study Details button > Description tab 

Enter the scenario into the Study instructions field.  

 

Morae Scenario Tips 

 Use the Morae Add-In for Word to add the scenario to the test protocol (example in Appendix B: Test 
Protocol Document).  

 To avoid printing test paperwork for participants, you can test with AutoPilot to present the tasks onscreen 
to the participant. AutoPilot presents the scenario to the participant right on the computer screen. See 
AutoPilot in the Morae Recorder help for more information. 

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study 
Description > Study Instructions. 
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3. Define Tasks 
The tasks should relate to real-life actions that fit the scenario. For more on how to create tasks, see 
Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning Center.. 

For example, if we use the example scenario of ñYou have just purchased a copy of SnagIt and youôre 
interested in learning more about the company that makes it, TechSmith,ò our first task is to find the 
TechSmith web site. 

Tasks in Morae Configuration 

 Recorder > Modify Study Details button > Task Definitions tab 

For each task, enter a name, description, and instructions for the participant.  

 

Morae Task Tips 

 Use the Morae Add-In for Word to add the tasks to the test protocol (example in Appendix B: Test 
Protocol Document) on the Task pages. Each task should be on a separate page so the participant can 
only see one task at a time. 

 To avoid printing test paperwork for participants, you can test with AutoPilot to present the tasks onscreen 
to the participant. See AutoPilot in the Morae Recorder help for more information. 

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Tasks. 

http://www.techsmith.com/learn/morae/default.asp
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4. Define Markers 
After you have come up with the scenario and tasks, create the markers. Markers allow the Observers to flag 
specific, important points in a recording and the start and end of tasks as they happen. It is important to figure 
out what kinds of actions you want to define marker for because, by flagging important points during recording, 
you can save time when you later analyze the results.  

For example, mark:  

 Participant actions 

 Participant comments and questions 

 Participant frustration 

 Areas where a participant gets stuck 

 Application or web site design issues 

 Observations about how the participant performs a task 

 Interesting comments or actions to include in a highlight video  

 Moments when participantôs access Help, want to contact customer service or technical support  

You can also add notes to provide additional details for each marker. All the markers and notes are 
synchronized with the video and saved in the recording of each test session. 

Morae also includes the ability to score markers, for example, you can use the score to log serverity of errors, 
from 0 (severe) to 2( minor). Manager can automatically calculate the average severity of the errors.  

Markers in Morae Configuration 

 Recorder > Modify Study Details button > Marker Definitions tab 

In Morae, a marker definition includes a letter (keyboard shortcut for logging), text description, and 
color.  Each study configuration template includes a default set of markers. The Software or Web Usability 
Study template includes the following markers:  

Q ï Quote/comment X - Error 

H ï User needs help O- Observation 

P - Participant prompted V ï Video clip 

Use the provided default markers, modify the markers, or create new markers that match the goals of your 
study or identify specific things you want observers to watch for during a session. 

Morae Marker Tips 

 There is no correct number of markers. The object of logging markers during a test is to make it easier to 
analyze the test results.  

 If you have specific things you want to look for in a test, create a marker for that action, problem, etc.  

 Later when you analyze your sessions in Manager, markers help you sift through data and focus on what 
you want to analyze. For example, viewing all the Help requested markers may reveal an error where 
people are really struggling. 

 When you are ready to create video clips or a presentation for stakeholders, you save time by quickly 
going to the moments during the session that you marked to include in the highlight video. 



  

Page 11 

 

 For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Markers. 

5. Define Surveys 
With surveys, you can collect information directly from the participants. After you import recordings into 
Manager, you can view and compare responses, create graphs based on the surveys, and export results, 
including any freeform answers. 

Morae can deliver multiple surveys to participants during a session. For example, surveys can be delivered 
before the test, after each task, and after the test. 

The template study configuration includes surveys. Use or edit the surveys provided or create your own 
surveys.  

Surveys in Morae Configuration 

 Recorder > Modify Study Details button > Survey Definitions tab 

Create and associate surveys with session events, such as the end of a task. 
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Morae Survey Tips 

 Associate a survey with the beginning of recording, end of recording, or the end of each task. 

 By associating a survey with a session event, it is ñlinkedò to that event.  

 AutoPilot automatically displays surveys when the associated session event occurs.  

 Observer readies the survey associated with the current session event.  

 Use the Morae Add-In for Word to add the surveys to the test protocol (example in Appendix B: Test 
Protocol Document).  

 The System Usability Scale (SUS) is freely available for use in usability assessment and has been used 
for a variety of research projects; the only prerequisite for its use is that any published report must 
acknowledge the source of the measure. If you use the SUS, add the following to your report: 

ñSUS was developed as part of the usability engineering program in integrated office systems 
development at Digital Equipment Co Ltd., Reading, United Kingdom.ò 

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Surveys. 

6. Save Study Details 

 File > Save Study Configuration or click the Save Configuration icon. 

Study Details must be the same for all recordings in a study and include the items you have just defined: 

¶ Study name, description, and instructions 

¶ Tasks definitions and instructions 

¶ Marker definitions and instructions 

¶ Survey definitions and associations  

By saving the study configuration, and reusing that configuration, all recordings in a study have the same 
configuration and can be imported into the same study in Manager. 

7. Configure Recording Details 
Recording Details included in Morae study configurations define how to record the session, including the 
following: 

 File saving and processing options 

 Video sources 

 What data to capture 

 Who logs tasks 

 How to start and end test recordings 
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Recording Details in Morae Configuration 

 Recorder > Recording Details button  

The Recording Details of the template study configuration allow you to immediately conduct a recording. 

The Recording Details for the Software or Web Usability Study template include: 

 Prompt for file saving details when recording stops 

 Record the primary monitor and include a camera Picture-in-Picture (PiP) video 

 Capture all available system data, including mouse clicks, keystrokes, and screen text 

 Assign the first Observer connected to Recorder as the Task Logger 

 Start and stop recordings manually with Recorder 

Morae Recording Details Tips 

 Recorder automatically chooses the source camera for the PiP video. Verify the selected source is correct 
before recording. 

 If you change any Recording Details settings, the rest of the settings update to provide a valid or 
recommended configuration, if needed. 

 Recording Details are saved as part of the study configuration. While the Study Details must be the same 
for all recordings in a study, the Recording Details can vary in each recording. 

 To get the most out of Morae recordings, record all available data, including mouse clicks, keystrokes, 
and screen text. If you are not allowed to capture some of this data, click Capture Options and change 
the Data settings.  

For more information, in the Morae Recorder Help, see Define Recording Details. 

8. Complete Test Set Up  
Study configuration is now complete. Here are the final things to do before you start testing. 

 Create Test Protocol 

 Finalize Morae Recorder Setup 

Create Test Protocol 
The test protocol is a document of everything needed for a test. There is an example protocol document in 
Appendix B: Test Protocol Document. Use this as a template to create the protocol for your test.   

 Test Session Setup Checklist 

 Release Form 

 Facilitator Script 

 Participant Instructions and Surveys 

 Assemble Participant Paperwork (Optional) 

 Email Invitations for Observers 
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Test Session Setup Checklist 

Verify the computer setup is the same at the beginning of each test. A test setup checklist makes it easier to 
go from one test to the next as quickly as possible and make sure you do not miss anything. 

Make a list of all the things you need to do between tests and include it in test protocol document, such as: 

 Close the software program. 

 Clear the internet browser history, cookies, cache, etc. 

 Log out of an application. 

 Prepare participant forms (release form, surveys, etc.) 

Release Form 

A release form gives permission to record the test. Morae records the participantôs interactions on the 
computer along with video and audio of the participant.  

 Some participants may only allow you to record the screen activity and session audio. In the case that 
the participant does not want the camera video captured, choose not to include PiP in Recorder > 
Recording Details button > Capture Options. 

If the contents of your test require the participant to keep session and web site/product information 
confidential, include a non-disclosure agreement with your form. 

The example test protocol includes a sample release form that includes a non-disclosure agreement. 

Facilitator Script 

The facilitator script helps to explain the test session to the participant. The facilitator reads through the script 
at the beginning of each test session to ensure the participant understands what to expect during the test. 

Participant Instructions and Surveys 

Use the Morae Add-In for Word to put the scenario, tasks, and surveys into the protocol document. Open the 
study configuration in the add-in and drag the study and task instructions along with the surveys into the 
protocol. 

 

For more information, click the help button in the Morae Add-In for Word. 



  

Page 15 

 

Assemble Participant Paperwork (Optional) 

Once you finish the protocol document, you need to assemble any paperwork needed for the  test.  

 If you would like to cut down on the amount of paper needed for a test, you can use AutoPilot to 
automatically present surveys, study instructions, and tasks right on the computer running Recorder. To 
find out more about AutoPilot, in the Morae Recorder Help, see Autopilot. 

If you are printing paperwork, each participant needs a copy of the following: 

 Release form 

 Background questionnaire 

 Scenario/session instructions 

 Tasks 

For the facilitator, print out a copy of the entire protocol. In addition to the participant items listed above, 
include the following: 

 Title page 

 Session setup checklist 

 Participant paperwork coversheet 

 Facilitator script 

 Task success paths (the best way or ways to complete a task) 

 List of debrief questions (follow up questions for the end of the test) 

See the example test protocol in Appendix B: Test Protocol Document for an example of a complete 
protocol. 

Email Invitations for Observers 
Verify that all observers have Morae Observer installed on his or her computer. To make sure that all people 
that observe the test can connect to the session, send an email to each observer with the following 
information:  

 Name of test 

 Date of test 

 Time of test 

 IP address or name of Recorder computer 

 You may also want to include a list of the test tasks and markers to let the observers understand what 
they should watch for during the test. 
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Finalize Morae Recorder Setup 
Prior to a Morae test, complete the following tasks: 

 Complete the Pre-recording Checklist 

 Run a Pilot Test before Recording 

Complete the Pre-recording Checklist 

The following checklist describes critical points that reduce the technical issues you may encounter and 
improve Moraeôs overall performance.  

Step Description 

Verify the system 
requirements 

Verify your system meets the recommended specifications to get the most 
efficient performance from Morae. For more information, see Morae System 
Requirements in the Morae Recorder Help. 

Verify you have 
enough hard drive 
space 

Recording file sizes may be approximately 10ï15 MB per minute, but the actual 
size varies depending on many factors. You should have extra space available for 
the best performance during recording.  

As a general rule, maintain 5ï10 GB of extra hard drive space as a buffer beyond 
what your Morae recording files use. 

 We recommend initially saving your recordings to a local hard drive to 
eliminate the chance of data loss that can occur when saving over a network 
or to an external device. After the file is saved, you can copy the recording file 
to an external device. 

Test your setup and 
scenario 

Test your setup before the actual recording session to resolve any possible 
complications (such as firewalls blocking Observer(s) from connecting, etc.).  

We recommend running a pilot recording for a short period of time to test 
Recorderôs start and stop options and to verify Observer(s) can connect. For more 
information, see Run a Pilot Test before Recording. 

 In addition, use the Test Recording option in Recorderto create a 15 second 
recording to verify the screen, camera, and audio streams are being recorded 
properly. 

Verify Network 
Settings 

If Observer and Recorder are on the same Intranet, you do not need to disable 
firewalls. 

If they are not, verify that you either disabled any firewalls running on the Recorder 
or configured the firewalls to open the communication ports. See your network 
administrator for assistance.  

There are no firewall adjustments necessary on the Observer side.  

Disable desktop 
wallpaper 

Remove the background wallpaper on the desktop and use a solid color as the 
background to improve compression when you record the desktop. 

Open the study 
configuration in 
Recorder 

Open the saved study configuration in Recorder. 

Run a Pilot Test before Recording 

We recommend running a pilot test to verify Recorder is capturing data as expected. Conducting a short pilot 
recording helps you work out any network connectivity issues and test your automated start and stop options, 
if applicable.  
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Follow these steps to run a pilot test: 

Step Description 

1. Open your saved study 
configuration 

In Recorder, open the study configuration (.mrcfg) for this study.  

2. Start Recorder Click the Start button to start Recorder manually.  

3. Connect Observers to 
Recorder 

Connect one or more Observers during the pilot test. Verify that you 
can successfully connect each to Recorder. 

4. Complete a test task Run through one of the tasks. To test the logging functionality of 
Observer, have a team member practice setting markers while you 
complete the task.  

5. Stop Recorder Either stop Recorder manually by clicking the Stop button in Recorder 
or use the keyboard shortcut <Ctrl + Alt + Shift + F9>.  

6. Import the recording and run 
a search 

Save the test recording file and import it into a project in Manager. In 
Manager, verify the screen video, audio, and camera video recorded 
correctly. Use the Search to verify the other RRT data streams have 
been captured accurately. See Analyze and Present Findings for 
more information on how to do this. 

05_Analyzing_recordings.doc
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Record and Log Test Sessions 
In this section, we discuss how to record and log test sessions. Everything in this section is done in Morae 
Recorder and Observer. Included in the section are the following: 

 Observers and Logging 

 Start and Stop the Recording 

 Log the Sessions 

 Send Surveys 

 Save the Recording 

Observers and Logging 
Morae Observer connects to Recorder over a network and displays the full participantôs experience, including 
the screen, audio comments, and camera video. Each person using Observer can log markers, marker scores, 
and text notes that are sent back to the Recorder and saved with the recording file. 

 

By logging tasks, markers, and notes during the test session, you save time analyzing the recordings. In 
Manager, you can use the markers to pinpoint parts of the recordings you need to review, automatically 
create graphs, calculate marker scores, and more. 

Observers can connect prior to the beginning of a recording, as long as Recorder is running. Observers do 
not see the participant interaction until recording begins. 
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Observer Benefits 

Although you can log sessions in a variety of ways, using Observer in combination with Recorder provides the 
following benefits: 

 Stakeholders can connect to watch live sessions without the need be in the room with the participant or in 
an observation room. With Observer, stakeholders can connect from anywhere on the network. 

 Anyone logged into an Observer computer can add markers during recording complete with text notes. 

 Morae automatically collects and compiles everyoneôs notes. The recordings contain the markers and 
notes logged by all Observers.  

 Observer automatically saves and indexes the markers and tasks with the accompanying video and audio 
streams.  

 You can save a copy of the camera video, screen video, and audio streams as a WMV file for immediate 
playback or to share with stakeholders. 

For information on connecting Observers to a recording, in the Morae Observer Help, see Connect to 
Recorder. 

Start and Stop the Recording 
 The default way to start and stop recordings is to manually start and stop Recorder using the following 
buttons: 

  

Start Stop 

If this does not meet your needs, Morae provides flexible options to start Recorder depending on your 
equipment and participant set up.  

For more information, in the Morae Recorder Help, see Define Recording Details > Recording Start 
Settings and Define Recording Details > Recording Stop Settings..  

Log the Sessions 
Once recording starts, the facilitator prompts the participant to begin the test.  

Each person using Observer can log markers, marker scores, and add text notes that are sent back to the 
Recorder and saved with the recording file. One Observer designated as the task logger logs tasks and task 
scores. You can save a copy of the recording as a WMV file for immediate viewing. You can also save a copy 
of your markers and notes. 
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The components used when logging in Observer are: 

 

Quick Tips for Logging a Session 

 There are several different ways to log markers and tasks. To find the one that works best for you, in the 
Morae Observer Help, see Log a Session > Markers > Different Ways to Log a Marker. 

 Tasks only appear in the Log if you are the task logger. 

 During recording, you can go back and edit previously logged markers and tasks.  

 The markers and tasks defined in the study configuration are available to log.  

 Log marker and task scores to use in Manager during analysis. For example, if you log marker scores, 
you can create a graph that automatically calculates error severity rate. 

 While you can add markers, tasks, and scores in Manager after importing the recording, you will save 
time by logging tasks and markers during a session.  

 You can save a copy of the Log after each session as a .txt file to print or open in other applications (i.e. 
Microsoft Excel).  

 If you need immediate access to the recording, from Observer, you can save a copy of the recording as a 
WMV. 

For more information, in Morae Observer Help, see Log a Session. 
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Send Surveys 
Deliver the surveys to participants during the recording anytime during the session. 

 Automatically ï Run the sessions with AutoPilot to automatically deliver surveys. 

 Manually ï All Observers can access and deliver surveys. If you manually deliver the survey during the 
session, Morae records the participant filling out the survey.   

 In Recorder, choose View > Deliver Survey or use the keyboard shortcut <Ctrl + Alt + Shift + F8>. 

 In Observer, select and send surveys in the log. 

 

Save the Recording 
By default, when recording stops, you are prompted for file details. Enter a name and description for the 
recording.  If you want to start another recording right away, in Recording Details, choose to defer the 
processing of the recording. You can later batch process recordings. 

For additional options, in the Morae Recorder Help, see Define Recording Details > File Details > 
Processing. 

 You cannot save a recording without a name. You can lose the data from a recording if the test 
participant, or anyone else, closes the dialog prompting for these details after the recording stops. 
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Analyze and Present Findings 
In this section, we discuss how to import recordings into Morae Manager, analyze data, create graphs, and 
create presentation materials for the test findings.  

 

Included in the section are the following: 

1. Import Recordings 

2. Edit Recordings 

3. Analyze Recordings 

4. Graph  

5. Create Highlight Clips 
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6. Create a Report 

1. Import Recordings 
To import recordings into Morae Manager, you first create a Morae project. Use a project to organize the 
recordings and studies in Manager.  

You can have multiple studies in a single project. The following are possible reasons to have multiple studies 
in a single Morae project: 

 You conduct the same test on different iterations of a product. 

 You conduct various tests on the same product. 

 You want to separate your studies by the experience level of participants. 

You can import a single recording into multiple projects. When you import a recording into a project, the 
original recording is not touched. A copy of the recording imported into the project. Any changes you make to 
this copy do not affect the original recording. 

You can import Morae recordings (.rdg), UserVue recordings (.rdg) and standard video files (.avi, .wmv, .asf) 
into a project. 

For more information on importing recordings and creating projects, in the Morae Manager Help, see Create 
and Modify a Project > Create a New Project. 

2. Edit Recordings 
View and edit the imported recordings in the Analyze Tab. In Manager: 

 Review screen video automatically synchronized with user video and audio. 

 Create additional or edit the logged tasks, markers, notes, and scores. 

 Search across recordings in a study for specific event types or text that appeared onscreen (i.e., find 
every time the users clicked on a specific web page). 

 View and edit survey answers. 

For information, in the Morae Manager Help, see Analyze. 

3. Analyze Recordings 
Morae recording (.rdg) files are unique because they are composed of multiple, rich data streams collected by 
TechSmithôs patented Rich Recording Technology (RRT).  

For more information on what kinds of things to look for in the recordings, see How to Retrieve Your Key 
Measures from Morae. 

Managerôs Search allows you to quickly create custom searches to look for web page changes, window/dialog 
events, mouse clicks, keystrokes, screen text, markers, and tasks. 

You can use the pre-defined search profiles, define a new search, or create and save your own search 
profiles.  

06_Key%20Eval%20Measures.doc
06_Key%20Eval%20Measures.doc
06_Key%20Eval%20Measures.doc
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For more information, in the Morae Manager Help, see Analyze > Search for Data in Recordings. 
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4. Graph Data, Tasks, Markers, and Surveys 
Instead of manually calculating data and building graphs, Morae creates graphs to help you share results 
faster, without manual calculations and scrubbing of data.  

Quantitative data provides hard evidence of usability issues, which complements the qualitative highlight 
videos. Highlight videos can be more powerful with graphs included to support the video clips. 

Morae automatically calculates and graphs the usability metrics specified in the Common Industry Format 
(CIF) standard ï effectiveness, efficiency, and satisfaction: 

 Measure effectiveness with error rate and completion rate graphs 

 Measure efficiency with a time on task graph  

 Measure satisfaction with a System Usability Scale (SUS) survey or customized survey delivered to 
participants at the end of the recording 

Example Uses of Graphs 

Here are three examples of graphs you can create in the Morae Manager Present tab and the reasons why 
you might want to use these graphs. 

SUS Survey 
Graph 

   

Use this graph to measure satisfaction from a 
System Usability Scale (SUS) survey.  

SUS scores can range from 0 (very little 
satisfaction) to 100 (very high satisfaction). 

Survey 
Analysis  

SUS Survey 
Calculation 

Time on Task 
Graph 

    

Use this graph to measure efficiency.  

Efficiency is usually measured by determining how 
quickly participants are able to complete scenarios 
or tasks.  

Participants may be able to successfully complete 
an activity, but they take a long time.  

Task Analysis Time on Task 

Mouse Clicks 
Graph 

   

Use this graph to measure the number of clicks 
required to complete a process.  

Add a constant line to show optimal clicks. For 
example, if the goal is for participants to find 
information on a web site in three clicks or less, 
you can easily see if that goal has been met. 

Input Device 
Analysis 

Mouse Clicks 

 

For more information, including more example graphs and uses, in the Morae Manager Help, see Graph > 
Graph Analysis Examples. 
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5. Create Highlight Clips 
When you are ready to organize the results of your analysis into a highlight video for presentation, select 
Managerôs Present tab. Use the Clip Bin and Storyboard to create, view, edit, and sort video clips, title clips, 
and graphs and assemble them into a video presentation. 

In the Present tab, assemble the important video clips, graphs, and tasks into a highlight video to share with 
stakeholders. Include just the participantôs screen and audio in the highlight video or add a Picture-in-Picture 
(PiP) window showing the participantôs facial expressions. The highlight video can be produced in AVI, WMV, 
or MPEG-4 format. 

 


